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� A few years ago I was visiting a niece in
Houston. It was time for her to take me to
the airport for my return home. My niece had
never driven to that particular airport, so she

asked her father for directions. She mapped out her destination (in her
head) and off we went. We had a plan.

Along the way my niece and I were having a wonderful time, talking and
laughing. We knew where we were going but had not again mentioned our
plan. As time went on and our good times continued, we reached a point
where we began saying, “We should be there by now.” With no reference
to the plan, we just continued driving. Finally, she called her father. I heard
her say, “What tower? What hangars?”

The end of this embarrassing story was this: We turned around and when
we actually looked, the airport was right there. As were the planes flying
right over our heads! We had driven right past our destination.

We all have destinations in mind, and hopefully your journey there is
enjoyable, but in order to reach that destination on time, as planned, we
must maintain focus. We need to know where we are every step of the way
and when and how to make corrections if needed. Otherwise, even the
smallest distraction can take us off course.

The end of this Toastmasters year is approaching. I expect you had a
 destination in mind that you wanted to reach. Perhaps it was to earn your
Competent Communicator or Competent Leader award. Perhaps you were
aiming for an even further destination of Distinguished Toastmaster. If you
are a club or district officer, I hope your destination was set to become a
Distinguished Club or District. Where are you in your journey?

I was recently visiting with a Toastmaster who shared with me that his club
had been a President’s Distinguished Club every year since the program exist-
ed – except one. That one year it missed being Distinguished by one member.
He said club members simply lost focus. They thought they were on track to
reach their destination and no one went back to the plan to be certain.

Fellow Toastmasters, where are you on the road to your destination? What
do you lack to reach it? Is it delivering two more speeches? Chartering one more
club? Adding two more members? Now is the critical time to know – and
do – what you need to do to arrive. Don’t wait until it’s too late! As I once
read on a billboard: “Success is 10% inspiration, 90% last-minute changes!”

As June 30 approaches I encourage you to stay the course. Focus on
your plan. Make changes if necessary. Have the Courage to Conquer Your
Destination!

The Courage to
Conquer Your
Destination
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LETTERS

same problem; one of them, unlike
me, was not able to recover and
finish her speech. Yet neither of
these two contest “losers” gave up;
both continued on as Toastmasters
and achieved bigger and better
results.
As Mr. William would say, I’ve

already won by trying.
Dean Lampman • Public Health Speakers • Fort Worth, Texas

Green and Growing
In her March “Viewpoint”, Jana
Barnhill wrote, “I am reminded of a
favorite saying: ‘When you’re green
you grow, when you’re ripe you
rot!’” These words inspired me to
give a speech encouraging all mem-
bers, especially long-time ones, to
start doing more presentations and
to purchase and complete the
Competent Leadership manual. The
speech was titled, “When you’re
green you grow,” which intrigued
the audience. When I repeated the
title and added the next phrase,
they were all ears. 
Thanks for the inspiration!

Lyn Hill, DTM • London Western Toastmasters Club
London, Ontario, Canada

again demonstrated when the deci-
sion was made to discontinue the
Bravina “speech pill” advertisement
in the Toastmaster due to members’
critical responses. Please continue
this important and rare quality.
Patt Harper, DTM • Lincoln Toastmasters • Lincoln, Nebraska

A Winner All the Way
I recently participated in an area
speech contest. After getting through
about 75 percent of the material in
my speech, I forgot my next line
and, regrettably, took a considerable
time to recover. I didn’t think fast
enough on my feet to ad lib my way
out of the situation. Worse, when I
forced myself to proceed, my nerves
showed a bit and my delivery was
imperfect for a line or two. I placed
second in the competition.
After the contest, I re-read an

article in the March issue of the
Toastmaster, by Colin T. William
(“No One Loses in This Speech
Competition”). In 2007, he had
drawn a blank in the middle of his
district speech. My Toastmasters
mentor also told me that she has
seen other speakers experience the

Speech Inspiration
I enjoyed David Brooks’ article on
President Obama’s inaugural address
in the March Toastmaster (“Different
by Design”). Moved and motivated
by the content and delivery of the
new President’s message, I made it
the subject of my sixth club speech
(vocal variety). Using a YouTube
clip, I examined the speech for use
of traditional inaugural rhetoric, and
I found supporting quotes.
Initially, I was worried that this

academic approach would not be of
interest to my audience. However,
my speech, “The President has
Spoken,” was well received and
sparked an after-meeting discussion
with several members. It is wonder-
ful to be among people who share
an interest in public speaking and
can discuss the President’s ideas in a
non-partisan manner.
Char Hopela • Sound Speakers • St. Cloud, Minnesota

The Gift of Feedback
I belong to a young Toastmasters
club within a government depart-
ment and also serve on its executive
committee. Until joining, I was
under the impression that I was a
fairly decent speaker – but I soon
realized I was wrong. I got very
good feedback from fellow Toast -
masters, who are very supportive.
They clearly exposed my drawbacks
without judging me. I have learned
a lot after becoming a Toastmaster
and am learning more. I am now
requesting that my friends and co-
workers become Toastmasters. Glad
to be a Toastmaster!
Mahesh Kashyap •Vincent Massey Toastmasters • Gatineau, Quebec

The Members Have Spoken
One of the reasons I’ve stayed in
Toastmasters for more than 16 years is
the philosophy of a “member-driven”
organization. This concept was once

Do you have something to say? Write it in 200 words
or less, sign it with your name, address and club
affiliation and send it to letters@toastmasters.org.
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Toastmasters in the Social Networks
� As a group, Toastmasters mem-
bers have embraced online social
networks in a big way. Tune in to
any of the most popular social net-
working sites – Facebook, LinkedIn,
YouTube, Flickr – and a quick
search on the word “Toastmasters”
will turn up hundreds if not thou-
sands of enthusiastic member con-
tributions. Online profiles of
Toastmasters members throughout
the world, photos of current and
historical Toastmasters meetings,
videotaped club meetings and
speech contests, vigorous debates
on Toastmasters policy issues – all
of this and more can be found with

By Joe McCleskey

For videos and digital photography,
make sure there’s enough light in
the scene and that the light falls on
the front of your subject, not on
your subject’s back. For audio and
video recordings, be sure to use a
good-quality microphone. Even if
you don’t have the best equipment,
a  little care (and research in profes-
sional  techniques) can go a long
way toward improving your work.

� Remember the rules of online
behavior. When you’re participating
in a heated debate in an online
forum discussion, it’s easy to forget
that people can’t hear you or see

at a club meeting or speech contest
without the permission of everyone
who might appear in your video or
digital photo (audience included).
Remember, too, that Toastmasters
is a place where people can over-
come their fear of public speaking
in a safe environment, and the
thought of being recorded or
 photographed makes some
 members very uncomfortable.

� Represent the organization with
dignity. Whenever you associate
your online activities with the
Toastmasters name, you become
an ambassador to all current and

How to refine what you do online.

“Remember, Toastmasters is a global organization, and a photo, video

or forum post that you may find humorous or harmless could very well

be deeply offensive to someone in another part of the world.”

just a few mouse clicks and a
broadband Internet connection.

If you haven’t done so, why
not explore the many social net-
working opportunities available to
Toastmasters online? But before you
participate, please take a moment
to consider the following advice:

� Respect the privacy of your
fellow Toastmasters. You don’t
have the legal right to videotape,
photograph or record the voice
of anyone who hasn’t given you
 permission to do so, much less the
right to post that image or record-
ing on the Web for all to see. This
means you should never bring out
your camcorder or digital camera

future members worldwide who
may  happen to view those activi-
ties. Remember, Toastmasters is a
global organization, and a photo,
video or forum post that you may
find humorous or harmless could
very well be deeply offensive to
someone in another part of the
world. This doesn’t mean you can’t
be yourself when you’re online; it
means only that you should be as
respectful and judicious as possible
when representing Toastmasters to
the online community.

� Pay attention to quality. If you
do decide to take some photos or
shoot some video to share online,
get the best quality shots you can.

your hand gestures. This often leads
to a breakdown in communication
when forum participants don’t
understand that something is said
in jest, or when a comment can
appear more mean and spiteful
than intended. It’s always a good
idea to be as kind and understand-
ing as possible in any online discus-
sion, even when you’re passionate
about the topic, and to remember
that there’s a living, breathing
human being at the other end.

Joe McCleskey is Manager of
Educational Development at
Toastmasters World Headquarters
and a former editor for Videomaker
Magazine.
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Global
Representation

& Support
� In August 2009, every Toastmas ters club in the
world will vote on a very important set of governance
changes that would
take effect in 2010.
If passed, these
changes will
improve the way
Toastmasters is
structured on a global scale, ultimately enhancing
 service to every member.

The Future is Yours.
When it is time to vote, mark “YES” on your ballot.
In doing so, you stand for a global organization that
is committed to making a difference by representing,
 supporting and ensuring success for every Toastmaster
in the world.

For more information visit:

www.toastmasters.org/future
Or e-mail questions to:

governance@toastmasters.org

Proposed Plan Summary

Global representation with 14

regions/directors

14 region advisors marketing

International Leadership Committee

Year-round training oppor tunities

for district leaders (e-learning and

face-to-face)

Move regional business and speech

contests to International Convention

More effective leaders = enhanced club support = an enriched member experience.

Watch International President Jana Barnhill’s
video message about this proposal:
www.toastmasters.org/future

Cast Your Vote For

Toastmasters is Global. Toastmasters is You.
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How to make the most of online innovation.

By Dave Zielinski

“The term ‘Web 2.0’ describes the changing trends in the use
of World Wide Web technology and Web design that aim
to enhance creativity, communication, secure
information sharing, collaboration and
functionality of the Web.”
– WIKIPEDIA DEFINITION.
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“Think of LinkedIn

or Twitter as

online versions

of a Rotary

club or golf

country

club.”

Web 2.0 isn’t just for teenagers using Facebook or
MySpace anymore. Helminiak is among a growing num-
ber of businesspeople, including many Toastmasters,
who use these new applications to run their small
 businesses more efficiently, network with peers, track
customer perception of their products or services online
and promote their organizations.
In these tough economic times, those who have lost

jobs, homes or much of their retirement accounts also
are using Web 2.0 networks as a way to connect,
 commiserate and build a sense of community so they
don’t feel so alone.
It’s the practical uses of Web 2.0 that have really

 captured the imagination of the business community. For
example, Helminiak uses Web services – in essence, soft-
ware that resides on the Internet instead of on computer
hard drives or servers – for a plethora of operations in
her small business. She uses Basecamphq.com for pro-
ject management, Quickbooks.com for her financials,
Harvest.com for time tracking and Salesforce.com for
customer relationship management, to name just a few
applications. What’s the benefit of this rent-a-software
model? It reduces the hassles of software installation,
gives users the flexibility of leasing instead of buying
and ensures access to the latest version of software.
It also places the user in an instant online community,
where help with problems is only a click away.

Networking Online
On the networking side of Web 2.0, sites like Twitter,
Facebook and LinkedIn have taken Web collaboration
and interactivity to a new level. One benefit to online
business networks like LinkedIn comes in creating a
“personal friends,” or business connections group as part
of your site profile. This function enables online friends
to easily search your personal network for any relevant
business contacts, valuable for things like job hunting.
Some LinkedIn members use the site to update their
 network on business services they offer – with the smart
ones avoiding any semblance of a hard sell. Many of
these sites also allow you to publish your own blog.
Some large companies have created their own inter-

nal versions of social networks. Best Buy, the electronics
retailer, established its “Blue Shirt Nation” to enable
employees to ask and answer questions, help solve
each other’s problems and swap sales tactics. This online
“trading post” has helped boost sales and enhance
 customer service. 
Others are using Web 2.0 to monitor social network-

ing sites for comments or concerns made by users about
their businesses. Comcast Corp. made news last year
when a top executive responded within 20 minutes to
complaints about a cable outage posted by a blogger on

isa Helminiak relies so heavily on Web

2.0 tools to run her company that taking

them away would be tantamount to

removing her from life support. The president

of Azul 7, a technology-services firm in

Minneapolis, Minnesota, Helminiak uses

Web 2.0 – so named because it represents the next
 generation of Web applications – for myriad purposes

encompassing account-
ing, business planning,
marketing and net-
working. Included
under the Web 2.0

umbrella are technology
tools such as Web  services,

social networking sites, Web
feeds, podcasts, blogs, viral

videos and more.
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Twitter.com. The executive made sure a technician was
dispatched post-haste to fix the customer’s problem. And
Dell, the computer manufacturer, has a dedicated team
of 40 customer service employees who spend their days
talking to customers on Facebook, Twitter and the like
to address any Dell-related complaints or questions
 posted to the sites. The idea is to get upset customers
to talk directly to the company, rather than spread their
displeasure far and wide on Internet message boards. 

Blogs, another proliferating Web 2.0 tool, offer an
important new way to keep your name in front of
potential clients or business contacts. Those who
become commentators on well-trafficked blogs, for
example, often gain credibility and visibility that lead
to new business opportunities.

“What’s interesting about Web 2.0 is it pushes organiza-
tions to look at their employees more as individuals, rather
than as a collective unit,” says Helminiak, the Azul 7 tech-
nology company president. “For example, we encourage
everyone in our company to comment on our blog, and
we give them a set of possible topics they can talk about.”

While promoting that individual voice is easier for
smaller companies that may not have the bureaucracy or
legal concerns of their multinational brethren, Helminiak
says blogging and use of internal information-swapping
networks, such as Blue Shirt Nation, are making inroads

in larger companies, as well. Online templates and
 blogging software like Wordpress.com have made it
 relatively easy for any company to start its own blog.

Viral Videos Take Off
The growth of broadband – bigger Internet “pipes”
through which to transmit video, audio and data – has
created new ways for companies to tell their stories using
Web 2.0, says Albert Maruggi, president of Provident Part -
ners, a marketing firm in St. Paul, Minnesota. One way
they’re doing that is through “viral video” campaigns to
promote products or services; using this guerilla marketing
technique, companies shoot their own videos and upload
them to online sites. Maruggi knows of one software
com pany that films short, gritty videos inside customers’
offices that feature users talking about how the software
has improved productivity and profitability; then the com-
 pany posts the videos to Blip.TV and YouTube.com
sites. The idea is to give the company exposure beyond
its own Web site, and in the process drive more traffic
back to that site. Some small businesses link their videos
to community pages on social networking sites, making
it that much easier for search engines to find them.

A related Web 2.0 tool that’s being embraced by
more Toastmasters clubs is podcasting. Podcasting is an
easy-to-master audio technology that’s an alternative to

The ‘Middle Children’ of Web 2.0
Most of us are familiar with popular Web 2.0 tools such as blogs, podcasts and social network sites

(Facebook, Twitter, MySpace). But there are other arrows in the Web 2.0 quiver that don’t have the

same familiarity or name recognition. Here’s a rundown of some of those lesser-known tools: 

� Wikis. A wiki is a page or collection of Web pages that enable anyone who accesses them to modify or con-

tribute content. The online encyclopedia Wikipedia is one of the best-known examples. Your company might

use a wiki to  create a central database of online knowledge on particular topics, be it information technology,

regulatory issues or successful sales practices, that everyone in the organization can contribute to.

� RSS Web Feeds. “Web feed” formats are used to publish frequently updated content such as blogs, podcasts,

video or news stories in a standard format, sending them out on a regular schedule to users.  Web feeds bene-

fit publishers by allowing them to syndicate content in an automatic fashion, and they help users by creating a

standard way to receive updated content from Web sites, or to combine feeds from many sites into one place. 

� Web Services. Also known as “cloud” computing, Web services represent software you access and use over

the Internet, rather than the kind you download to hard drives or workstations.  Web services provide a way

of outsourcing functions you once performed in your own organization, offering the advantages of “renting”

rather than owning business applications.

� Folksonomies. Folksonomies are a way of indexing or “tagging” online content to better categorize and

 organize it. What distinguishes folksonomies (think plain old folks + taxonomy) is that they’re generated not

just by experts, but by creators or users of content as well. User-chosen keywords are used to organize

 content instead of a defined  classification vernacular.

� Video sharing sites. These are sites, such as YouTube or Blip.TV, that allow people to upload and share their

 promotional or informational videos with the public at large. Companies often use the sites as a way to market

their businesses and drive more traffic to their Web sites.
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T

traditional marketing or public relations tactics. One
 reason for podcasting’s growing popularity is that many
journalists, who once relied on press releases received
directly from companies to get their story ideas, now
conduct online searches for interesting podcasts and
blogs to spark those ideas. 

Slow But Steady Adoption
Although Web 2.0 has entered the business mainstream,
its many tools are still used primarily in smaller or more
entrepreneurial companies, with larger companies slower
to board the bandwagon. According to a survey by the
consulting firm McKinsey and Co., companies reported
using about three Web 2.0 tools on average in 2008, up
from two in 2007. 

One reason for the slow embrace is that executives
of the cell-phone generation, still higher on the organiza-
tional food chain than up-and-coming managers of the
Web generation, are hesitant to believe that tools such
as online social networks can produce the kind of sales
leads or business connections that traditional sales or
networking tactics can.

Maruggi counsels clients of a certain age to think of
LinkedIn or Twitter as online versions of a Rotary club

or golf country club. The same effort, knowledge and
credibility needed to make connections in those brick
and mortar settings is what’s needed in the virtual world

to generate new business, referrals or positive word of
mouth. But just as in those time-honored settings, sales
rarely happen overnight online, and rarely as the result
of any hard sell. 

“Like any relationship, the more you give, the more
you usually get with online business networks, but the
payoff may not happen tomorrow,” Maruggi says. “But if
you create a reputation for providing good advice and
useful information, and not just for self-promotion, those
sales and referrals will come.”

Dave Zielinski is a freelance writer who divides his time
between Wisconsin and South Carolina.

“A related Web 2.0 tool
that’s being embraced by
more Toastmasters clubs

is podcasting.”
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4. the sum of the ways in which
one social group – geeks – gets its
revenge on another social group –
the rest of us – for making fun of
them in high school. 
[< Gk technología, systemic igno-

rance. See DUMBO— , —LOGY.]
Most of the technology I

encounter comes with “Operating
Instructions,” written in a nonde-
script pamphlet that says failure
to read the contents may result
in my death. Electrical shock
appears to be the most likely
cause, although once you get up
into power tools the possibilities
are so endlessly gruesome it just
says  “serious injury” and leaves
the rest to your imagination.
The assumption, of course, is

that you will understand what you
read in the contents. I honestly
believe that at the end of all the
safety instructions they should add
one more: “If you do not under-
stand these instructions, you are not
intelligent enough to operate this
product. Please return it to the store
and buy something that you can
operate. Like a yo-yo.”
The writers of these booklets

illustrate their meaning by including
schematics. It’s their way of saying,
“Here, let me draw you a picture.”
I followed a schematic once to
assemble a tricycle for my son and
proceeded to construct what can
only be described as a wheelbarrow
with antlers. My son cried. I cried,
too. I don’t like schematics.
I know I’m not alone. It’s become

a cultural cliché: the hapless con-
sumer who can’t program his TiVo,
the soccer mom who has to ask her
7-year-old to load up her iPod.

� In high school I was asked to
define the word “zoology” in a
vocabulary quiz. I answered that it
was the study of zoos. The next day
I got my test back. The teacher had
marked it wrong and written neatly
in the margin: “And I suppose car-
tology is the study of carts.” That’s
when I first suspected that not only
would my academic years be a
struggle, but that I would have par-
ticular trouble with anything ending
in “—ology.” I was right. Biology,
geology, zoology (animal biology;
who knew?) For any teacher trying
to explain these concepts to me, it
was, as Woody Allen puts it, like
serving tennis balls into the ocean.
So you can imagine how I feel

about technology. For me, this is the
ology of all ologies. The dictionary
defines it thusly: 

technology n. 1. the branch of
knowledge that deals with industrial
arts, applied science, engineering,
etc. 2. the terminology of an art,
 science, etc.; technical nomenclature.
3. a technological process, inven-
tion, method, or the like. 4. the
sum of the ways in which a social
group provides itself with the mater-
ial objects of its civilization. [< Gk
technología, systematic treatment.
See TECHNO— , —LOGY.]
My definition is different:
technology n. 1. the branch of

knowledge of which you have no
knowledge. 2. the terminology cre-
ated to ensure that you will never
have knowledge of that branch of
knowledge. 3. a technological
process, invention or method, the
successful operation of which
requires the exact knowledge you
do not have and can never learn.

Everybody thinks it’s funny. Look
at me! I’m being humiliated by an
inanimate object. Ha, ha, ha! And
look – I have an “error 52 that
resulted in system failure and wiped
out all my tax records.” Isn’t that a
riot! Wait, wait – there’s more. My
car dashboard just told me to
“check engine.” Why – so I can
FIX it?! Stop, you’re killin’ me!
I’m not laughing. Are you? Oh,

you are. Well, I’m not. I don’t
think it’s funny that my entire life
depends on a “branch of knowl-
edge” that sways in the breeze
miles above my head. The only
possible good I can see comes from
a sort of paradox: Modern technol-
ogy is blamed for alienating human
beings by enclosing us in our own
little worlds of home movies, cell
phones, listening devices and per-
sonal digital assistants. And yet
when these things break down they
do the opposite – i.e., force us out
of our electronic cocoons into
direct interaction with all manner
of fellow creatures we would never
otherwise embrace – namely, the
people who can fix them: auto
mechanics, cable guys, even tech-
nical support specialists in India
who make you feel like Gandhi is
fixing your computer.
I’ve dealt with all of these people

and have found them to be quite
friendly and willing to help. In fact,
when the guy came to install my new
HDTV, he said that once I mastered
the remote, he’d teach me about
something called the Internet.

John Cadley is an advertising  copy -
writer in Syracuse, New York. Reach
him at jcadley@mower.com.

Technically Speaking

T

The ology of
all ologies!
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Revenues and Expenses from Operations
Exhibit A shows the relationship of individual revenue
sources to expenses. You can see that income  generated
from dues renewals, new-member fees, charter fees and
miscellaneous sources was sufficient to cover expenses.
Exhibit B shows how revenue is spent. The glossary

below and on the next page gives an explanation of
expenses.

Glossary of Expenses:

� Officers, Directors and the Office of the Executive
Director – Includes travel and expenses for Board
 meetings, district visits, regional conferences and outside
professional services, such as legal counsel. Board meet-
ings ensure smooth operation of the organization and
ideas for new and exciting programs. District visits help
in building new clubs, strength ening membership and
bringing new ideas to members.

� Communications and Marketing – This section includes
the develop ment of new-member and new-club materi-
als, membership and club-building programs, promotions
and awards as well as the costs of producing and
 mailing the Toastmaster magazine.

� Operations and Administration – This section includes
member services and administrative services to clubs and
districts and covers  processing of dues renewals, officer
lists, club and district billings, new-member applications

Financial Activities: Jan.-Dec. 2008
The financial statements of Toastmasters International were audited by the independent certified public accounting
firm of Moore Stephens Wurth Frazer and Torbet, LLP. The statements were prepared in conformity with generally

accepted accounting principles. 
The Board of Directors of Toastmasters International controls the organization’s funds and, with the Executive

Director, is responsible for assuring that management fulfills its fiduciary responsibility. The Bylaws of Toastmasters
International require that the corporation’s financial status be reported to its clubs annually. To keep our entire
 membership informed, we are exceeding this requirement by reporting our financial results to all members.
Following is selected information from the year-end financial statements, including a bar graph and pie chart to

 provide a clearer picture of Toastmasters International’s 2008 financial activities.

and educational awards, as well as updating member
and officer infor mation. It also includes accounting and
financial reporting, governing  documents administration
and meeting planning.

� Production of New Educational Materials and Services –
Production of materials and  distribution of educational,
promotional and administrative materials. The most
 useful, up-to-date materials are available through the
TI Supply Catalog or online at www.toastmasters.org
to help every member succeed.

� Other – Includes annual convention expense, magazine
advertising commissions, interest on operating accounts
and depreciation.

� Technology Services – This section includes expenses relat-
ed to the software and support of our computer systems.

� Investment (Expense) Revenues, Net – This section includes
any gains, losses, income and investment expense for the
unrestricted marketable securities.

Exhibit A Exhibit B

Membership Dues – 62%
New

Member
Fee

14.4%

Sales of
Educational
Materials

16%

Expenses – 94%

REV ENUE  F ROM  OP ERAT I ONS

Other
7.6%
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STATEMENT OF FINANCIAL POSITION AS OF DECEMBER 31, 2008
ASSETS

Cash and short-term investments ..................................   $          4,925,194
Restricted cash and short-term investments .................   $          1,759,145
         Total cash, restricted cash and
         short-term investments .............................  $       6,684,339

Marketable securities ......................................................   $        15,447,064
Accounts receivable, net of allowance for doubtful
     accounts of $5,000 in 2008 and 2007 .....................   $              48,194
Inventories, net...............................................................   $          1,152,001
Deposits, prepaid postage and other............................   $            352,068
Land, building and equipment, net of
     accumulated depreciation........................................   $          3,527,119
         Total assets ...............................................  $      27,210,785

LIABILITIES AND NET ASSETS
Liabilities:
     Accounts payable and accrued liabilities................   $            858,638
     Funds held for Toastmasters International regions   $            173,198
          Total liabilities ..........................................  $          829,210

Net Assets:
     Unrestricted...............................................................   $          8,974,124
     Unrestricted – reserved per policy..........................   $        14,917,250
          Total unrestricted......................................  $      23,891,374

     Temporarily restricted ..............................................   $          2,287,575
         Total net sssets .........................................  $      26,178,949
Total liabilities and net assets .............................  $      27,210,785

TI SELECTED FINANCIAL INFORMATION JANUARY-DECEMBER 2008

The Ralph C. Smedley Memorial Fund
This fund was established to provide financial support for 
Toastmasters International’s educational programs.  These
include the creation of new and innovative educational
materials for club and member use, the development of
promotional material designed to spread the word about
Toastmasters, and development of new educational
programs, such as the Leadership Excellence Series. 
It also includes market and member research.

The fund is comprised of donations from individual Toastmasters and Toastmasters clubs, interest earned and the
increase in the value of investments on those donations.  Contri butions from January 1 - December 31, 2008 totaled
$19,518.  The fund had a balance of $529,814 as of December 31, 2008.

STATEMENT OF ACTIVITIES FOR THE YEAR ENDED DECEMBER 31, 2008

CHANGES IN UNRESTRICTED NET ASSETS:
   REVENUE FROM OPERATIONS:
       Membership dues and fees:
           Member dues ....................................................   $        9,390,831
           New member fees ............................................   $        2,180,836
           Charter fees .......................................................   $          150,123
       Total membership dues and fees....................   $    11,721,790
       Other revenues:
       Sales of educational materials ...............................   $        2,410,759
       Annual convention.................................................   $          622,750
       Interest ....................................................................   $          130,190
       Royalties..................................................................   $              8,331
       Magazine advertising .............................................   $          186,778
       Other.......................................................................   $            23,658
       Total other revenues ......................................   $      3,382,466
       Total revenue................................................   $    15,104,256           

   OPERATING EXPENSES:
       Executive director; officers; board ........................   $        1,172,166
       Communications and marketing ...........................   $        3,531,643
       Technology services...............................................   $          756,537
       Operations and administration..............................   $        4,809,748
       Production ..............................................................   $          897,692
       Cost of educational materials ................................   $        1,757,413
       Annual convention.................................................   $          878,662
       Magazine advertising .............................................   $            37,350
       Depreciation – other..............................................   $          207,040
       Depreciation – technology ....................................   $          170,556
       Total operating expenses .............................   $    14,218,807
       Increase in unrestricted net
       assets from operations .................................   $        885,449

   INVESTMENT (EXPENSES) REVENUES, NET:

       Marketable securities
       Interest and dividend income ...............................   $          665,668
       Net realized (loss) gain on marketable securities   $       (1,388,642
       Capital gain distributions.......................................   $            45,122
       Net unrealized (loss) on marketable securities .......   $       (5,064,496
       Investment Fees .....................................................   $         (176,883
       Total investment revenues, net .......................   $     (5,919,231
   (Decrease) increase in unrestricted net assets ...   $    (5,033,782

)

)
)
)
)
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By Lin Grensing-Pophal

Do You Blog?

Deck ???

Maximize your Web presence
by showcasing your expertise.

In 2004 Ted Demopoulos, a consultant,

speaker and author of Blogging for

Business, started a blog, he says, as “an

experiment.” He’d been reading blogs for a

few years – since about 2000 – and was very

familiar with them. So he put one posting

“out there,” as a “kind of joke” just to see

what would happen.

“I didn’t expect anything to happen very quickly,” he
recalls. “But literally overnight my search engine results
were greatly enhanced. I was shocked. Within the first
month the traffic to my Web site doubled.”

Demopoulos has been a consultant since 1990, and
says his blog “has helped my consulting business exten-
sively.” Blogging, says Demopoulos, has “helped me sell
keynote speeches, consulting and training and has
absolutely gotten me new clients.” In addition, he says,
“It has enlarged my footprint with existing clients by
showcasing my range of expertise.”

You’ve probably heard about blogging and have a
general idea that it involves some sort of Internet-based

By Lin Grensing-Pophal
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communication.
Or perhaps you’ve
already discovered
some of the benefits
of blogging and are
using these benefits
to your advantage –
either as a visitor
or as the author of
your own blog.

But if you want to broaden your understanding of
the phenomenon of “blogging,” here are the basics:

What Is Blogging?
Blogs – more appropriately and formally called “Web
logs” – are ongoing, informal communications about top-
ics of interest. One estimate claims more than 10 million
blogs in the United States alone. Why the proliferation?
Because they are easy and inexpensive to create.
Vlogging – a relatively new term – has cropped up to
refer to video blogs, a concept popularized by sites like
YouTube.

Bill Ives is the co-author, along with Amanda Watlington,
of Business Blogs: A Practical Guide. While researching
the book, Ives interviewed 70 successful bloggers. Blogs,
says Ives, offer a number of benefits. They:

� Create a searchable archive of content where
every entry has a unique URL, which makes it
easier to find through Google or other search
engines.

� Promote ongoing, dynamic communication.
� Promote transparency – they can be open to the

entire world, or they can be password-protected to
allow access to only a specific audience. 

� “Level the playing field” in terms of marketing com-
munication. There are a number of cases, says Ives,
where “individual consultants or small businesses
were able to gain tremendous traction and visibility in
the Internet through their blogs.”

� Are very inexpensive to create – even free. Costs
range from hosted blogs that cost nothing to blogs
that are more expensive and offer a variety of fea-
tures. In any case, says Ives, a blog is less expensive
than a traditional Web site.

Getting Started
When considering whether a blog would make sense
for you, it really comes down to two very simple – yet
critical – questions:

1. Do you have something to say?
2. Does anyone care?

Tips for Bloggers
For Toastmasters who are considering their own blogs, Katherine Smith, who runs a blog

at www.katherine-smith.com, offers three pieces of advice:

1. Write regularly. “I haven’t kept up with it the way I should,” she admits.

2. Remember that anyone can read it. “Don’t disclose anything in your blog that you

wouldn’t disclose to a room full of strangers.”

3. Be specific. “If your blog is about team-building, don’t suddenly write about wage and

hour laws.”

Margaret Graziano, founder and CEO of KeenHire, an HR consulting practice, adds to this

list, and advises the following:

� Do not use your blog as a self-promotional or advertising tool.

� Do not link to gossipers and stay away from complainers.

� Remember that “like attracts like” – be where the positive energy is flowing.

� Be conscientious about spelling and grammar – your credibility is at stake.

� Seek out and link to powerful people.

� Practice good etiquette – be gracious and practice reciprocity.

� Acknowledge people for their input, advice, introductions and referrals.
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If you answered “yes” to both of those questions,
here’s how you can get started:

Get to Know What Blogs Are All About
Spend some time reading blogs, suggests Demopoulos.
The content of those blogs could be virtually anything,
but he advises, “Spend some time concentrating on your
industry and your area of expertise.”

How to find blogs? Here are two helpful search
engines: (see sidebar) www.technorati.com and
www.blogdigger.com. 

Find Your “Voice”
“You want to have a consistent topic that’s directly
aligned to your business strategy and what you want to be
known for,” says Ives. Focus is key. “You should have a
title that’s reflective of what you’re trying to do and a
very brief purpose statement that says ‘here’s the pur-
pose of this blog,’ so people can see that quite readily.”

And, he adds, “You want to post fairly frequently. It
doesn’t have to be every day, but several times a week
or at least on some consistent basis so people can antici-
pate. The more frequently you can do it, the more likely
you are to attract a loyal following.” 

Make It Easy to Find You
“One error I see people make a lot is that they start a
blog and no one can find it,” says Demopoulos. “I

strongly recommend that people have a link to their
blog from their Web site. It sounds obvious, but it’s
amazing how many people don’t do this.”

Demopoulos also recommends including your blog in
your e-mail signature. His, for instance, reads:

Ted Demopoulos, Consultant and Professional Speaker
Demopoulos Associates
www.demop.com
Visit The Ted Rap Blog at www.demop.com/thetedrap/

Avoid Hype
While there are certainly bloggers whose objective is to
generate business, that is not always – nor should it be –
the main objective. In fact, says Margaret Graziano,
founder and CEO of KeenHire, a human resources con-
sulting practice, “If you use it as a forum for self-promo-
tion or advertising, you’ve missed the boat and will
alienate people.” Graziano is a prolific blogger herself
and says her blog is invaluable in her business, but she
cautions that having a blog is not about “just doing it” –
it is about doing it right. 

Blog Appropriately
Like any form of public communication, blogs can cre-
ate problems. “If you start saying bad things about peo-
ple, they can react and you can get into wars,” warns
Ives. “Certainly you don’t want to do anything that’s

Blogs on Public Speaking
There are plenty of blogs about public speaking, says Jorge Olson, Toastmaster, entrepreneur and consultant. To

find and keep up to date on them, he suggests that Toastmasters go to “Google alerts” and ask to be notified

on “public speaking.” Then, he says: “Every time someone – anyone in the world – adds something to their blogs

about public speaking you will get an e-mail with the link.”

“One site I encourage everyone to visit is Garr Reynolds’ Presentation Zen blog,” says Laurent Duperval,

president of Duperval Consulting in Montreal and a Toastmaster – http://presentationzen.blogs.com. 

This blog is required reading for anyone who uses PowerPoint, he says. “His views on presentation and design

have revolutionized the way I think of a PowerPoint slide,” says Duperval. “I used to suffer from ‘bulletitis,’

because I was too lazy and ignorant to do anything better,” he says. “Today my slides no longer contain bullets

and they have become very visual – I no longer use PowerPoint as a crutch, but, instead, to enhance the emo-

tional content of my message.”

Meredith O’Connor, marketing/communications director for Bates Communications, Inc., in Wellesley,

Massachusetts, recommends www.thepowerspeakerblog.com, from Suzanne Bates, author of Speak Like a
CEO: Secrets For Commanding Attention and Getting Results. “Suzanne writes her blog about communications and

speaking skills, examples of great speakers and leadership,” says O’Connor. 

Anyone interested in conducting more effective meetings and presentations should frequent the blog:

www.openingkeynote.com, says Jeff Davidson, of Breathing Space Institute, in Raleigh, North Carolina. 

Jorge Olson includes a directory of the best public-speaker blogs on his Web site: http://jorgeolson.com/
public-speaking-and-blogs.
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libelous or slanderous.” And you don’t want to infringe
on some one else’s copyright by posting information
that you haven’t created with appropriate permission
and credit.

Because of the power of blogs
and how quickly information is dis-
seminated, says Ives, some people
have gotten into trouble. “They’re
not always aware of the transparency
and exposure. Your words can be all
over the world very quickly.” 

How To Do It Right
Chakisse Newton is a speaker, consultant and executive
speech coach. She’s been a Toastmaster since 2003 and,
in 2005, was a finalist in the Toastmasters World
Championship of Public Speaking. As a speech coach
and a marketing consultant who helps companies devel-
op and communicate their key messages through blogs
and other marketing channels, Newton says she has
observed several key areas where speakers misuse their
blogs. The top three, she says, are:

� They forget that speaking is a “contact sport.” While
writing and contributing to blogs can be useful, she
says, ultimately true improvement comes only from
time spent on the platform practicing what you’ve

learned. “Too many speakers become so cerebral
about techniques for audience involvement and the
like that they abandon the one sure-fire way to
become a better speaker: stage time.”

� They don’t know that successful blogging is about
more than writing; it’s about creating a forum for dia-
logue and a sense of community. “The best blogs are
those that provide valuable information and also ask
readers to comment and provide their insights,” says

“The best blogs are those that provide

valuable information and also ask readers

to comment and provide their insights.”
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If You Build It…
They Do Not
Necessarily Come

Of course, as with Web sites, just having a blog

is not enough. Awareness needs to be creat-

ed to generate visitors. That can be done in a

number of simple ways:

� Include your blog address on your

letterhead and other business communica-

tion materials.

� Add information about your blog to your

e-mail signature.

� Include a prominent link to your blog on

your Web site.

� Talk about your blog at networking events,

professional meetings, etc.

Above all, keep it fresh and meaningful.

Bloggers who rise to the top of the list in

the blogosphere are those who consistently

deliver meaningful and valuable content to

a specific target audience that finds the

information so compelling, they keep coming

back for more. 

Newton. So many competing resources provide a
one-way channel of information that any blog or
resource that fosters community will stand out from
the rest, she says. This can be accomplished through
forums, comments or just soliciting general feedback.
Newton notes that, recently, a Toastmaster from
Dubai successfully used the Toastmasters network on
LinkedIn to request feedback on a blog.

� They start blogs without doing their homework.
“Despite all the hype around Web 2.0, not everyone
needs a blog,” she says. For those who do have value
to add, Newton suggests asking the following ques-
tions before moving forward:

• Who is the target audience for my blog? 
• What unique voice or point of view do I have to

offer? 
• How will I build my following so people actually

find the value that I provide? 

Katherine Smith is an independent consultant who
runs a blog at www.katherine-smith.com. Smith had
been reading blogs for a few years and says she was
“bored by a lot of the content – it wasn’t tactical enough
for me.” So she decided to start her own blog and timed
it along with her venture into consulting.

Starting a blog is not hard to do. Smith bought a
domain name through her Internet provider and took
advantage of a hosted service – Wordpress.com –
rather than hosting her own blog. “The truth is, unless
you’re drawing significant amounts of Web traffic, you
probably don’t need to host your own blog,” she says.
Another hosted service she recommends as a good start-
ing place is blogger.com.

Of course, it depends on your objectives. Jorge Olson
is an entrepreneur, consultant, keynote speaker and
author of The Unselfish Guide to Self Promotion. Olson is
also a Toastmaster and believes that public speaking is
one of the most effective tools for business, family and

life. While Olson also recommends WordPress – which is
free – he prefers to host his blog himself, noting that this
will generate more traffic and better Google rankings. 

Penny Sansevieri, author of Red Hot Internet Publicity
(Sourcebooks, 2009) and CEO of Author Marketing
Experts, Inc., specializes in Internet publicity and recom-
mends that Toastmasters interested in establishing a blog
use the following ideas to help build credibility:

� Become a filter – the go-to person for your area of
expertise. People love filters and when you’re a filter,
you’re considered an expert, Sansevieri says.

� Use your blog to review books or products in your
industry.

� Interview other professionals and turn your blog into
a resource.

� Blog on current trends. Keeping your finger on the
pulse of what’s going on will show that you are in
touch with your market. 

Blog frequently – a minimum of twice a week. That
way you keep your blog current and people will contin-
ue to read it, becoming more engaged in your message,
says Sansevieri.

Lin Grensing-Pophal is a freelance business journalist
in Wisconsin, where she also runs a communication
 consulting firm – Strategic Communications, LLC
(www.stratcommunications.com). She can be reached
at linda@stratcommunications.com.

T

“Do you have something

to say? Does anyone care?”
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By Narges Nirumvala, ACB

PowerPoint Made Easy
majority of people aren’t sure
where to begin when it comes to
using PowerPoint – and are too
afraid to ask.

So this article is meant to show
you how easy and fun it can be.
We’re going to put together a
PowerPoint presentation (also
called a slide show) in six easy
steps. For this exercise you will
need a desktop or laptop computer
already loaded with any version of
Microsoft PowerPoint (I like how
intuitive PowerPoint 2007 is, but
PowerPoint 2003 is good, too).

Step 1: Create your content. I am
a firm believer that your speech
should be written (most of it, any-
way, even if it’s in outline form)
before you start working on your
PowerPoint presentation. Why is
this important? Because you are
going to extract the necessary con-
tent from your speech and put that
into your presentation. Without
 content you have nothing. So let’s
say I’m giving my presentation for
project 7 from the Competent
Communication manual and have
written a speech about “How to
Lose Weight Safely and Effectively.”

During my speech, I’m going to
have an introduction, followed by
three well-researched points on
weight loss, then a conclusion.
This same information will trans-
late well into PowerPoint. You
would start in “Outline” view and
start typing in key items from your
speech. Typing is better than cut-
ting and pasting, because you
need to summarize the information
while you type it in. 

P
owerPoint saves lives! Okay,
maybe that’s taking it too far.
But it can save the day – espe-

cially when it comes to business
meetings. Effective use of presen-
 tation technology can turn a con-
fusing and tedious meeting into a
 stimulating and useful experience.

Let me give you an example.
A group from my home club –
Fyrebyrde Toastmasters – attended
our District conference recently. It
was a wonderful conference…but
then came the business meeting.
One key item on the agenda was
the financial report. I looked
around at our table and the neigh-
boring table but couldn’t find any
financials printed out. I assumed,

then, that the financial data was
going to be presented via Power -
Point so we could see the material.
Then I heard this strange, slow,
screeching sound and turned my
head to face the horror: It was
coming from an overhead projec-
tor that might have been from the
Stone Age.

The numbers on the transpar en-
cy were so small I couldn’t read
anything (and I have 20-20 vision).
I squinted and leaned forward
 trying to discern anything, but
there was no hope. The presenters
hadn’t brought handouts with
them, so since most of the audi-
ence members couldn’t read what
was on the overhead, a kind old
gentleman sitting near the front
said he would read out every line.
Every line!

An agenda item that should have
taken a quick 10 to 15 minutes was
stretched to an excruciating half
hour. Using better technology to
present the data would have engaged
the audience and made for a more
efficient meeting – and possibly
even better decision making.

I have never understood why
there aren’t more PowerPoint
 presentations at club meetings.
Why don’t more people use them
to complement their speeches and
educational sessions?

Toastmasters International even
provides a CD with a basic Power -
Point presentation for each module
of its education series. When I pre-
sented my first educational work-
shop on PowerPoint to a group of
Toastmasters, I asked this question
and was surprised to find that the

Liven up your business meetings!
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Step 2: Structure your content.
You need to distribute the content
between various slides. Let’s go
through a standard slideshow struc-
ture. First you need a title slide that
introduces you to the audience; in
going with the previous example,
the title slide could be labeled
“How to Lose Weight Safely and
Effectively” by Jane Smith, CC#7 –
ABC Toastmasters Club. Then the
next slide should be your introduc-
tion, just as in your speech. The
next couple of slides after that have
your core content – the three points
of the speech – so perhaps you’d
have one point per slide, with an
example or clip art with each one.
Finally, you’d present two closing
slides – one that recaps your points
again and then a “Thank you and
Questions” slide.
You should always end with a

slide that thanks the audience and
opens up the session (if there’s
time, of course) to questions from
audience members. So that means
we have seven slides altogether,
in our example, right? Let’s review:
We have the title slide, introduction
slide, point 1 slide, point 2 slide,
point 3 slide, closing slide and,
lastly, the “Thank You and
Questions” slide.

Step 3: Cut the fat or ‘de-clutter’
your slides. This is the most im -
portant step, but one people often
neglect! You need each slide to
have plenty of open or blank
space. Plus, your sentences should
be short, in the largest font possi-
ble. Remember, it should be clean,
clear and legible. You should have
only the most vital information on
each slide. The idea of Power Point
is to present the key points to the
audience in an intriguing way, so
audience members remain
engaged. A relevant acronym is
KISS: Keep It Simple Silly. So now
you have seven simple, easy-to-
read slides, right?

Step 6: Give it a trial run. Open up
PowerPoint on your computer and
prepare to practice your speech. Go
to “Slide Show” view and click to
start the slide show. This is a vital
step since it will give you the

opportunity to practice synchroniz-
ing your speech with your slide
show. You may need to adjust
some automated animation and
transitions to work with your spo-
ken words. This will also give you
the opportunity to see if you need
to improve the content on the
slides or perhaps even add a slide
or two. You may need to revisit
steps 5 and 6 to perfect your show.

Now your slide show should be
ready. At this stage you should re -
hearse it a few more times with your
speech, tweaking it if necessary.
One final point to keep in mind:

Always remember to take a print-
out of your presentation with you,
with enough copies for every mem-
 ber of your audience, so if you have
a technology hiccup, you can still
deliver a successful presentation. 
Now you’ve explored how to set

up your own PowerPoint presenta-
tion in six easy steps. This is just
the begin ning. Like anything in
Toast mas ters, the more you prac-
tice, the easier it will get. Also,
don’t be afraid to ask your speech
evaluator to assess the effectiveness
of your PowerPoint presentation.
After all, in Toastmasters we do
evaluate everything.

Narges Nirumvala, ACB, CL, is a
businesswoman, speaker and free-
lance writer. She’s a member of Fyre -
 byrde Toastmasters in Vancouver,
British Columbia, Canada. Narges can
be reached at nargespn@yahoo.ca.

T

Step 4: Add the formatting. For a
beginner or someone short on time,
the simplest way to do this is to use
a template. PowerPoint comes pre-
loaded with a number of excellent
designer templates (and you can buy

hundreds more online), each with
its own set of complementary fonts,
colors and design elements. Some
even have a theme, such as “indus-
trial” or “technology.”
Using templates is the easiest

way to make your presentation
look more professional and pol-
ished. Someone has already done
the work for you, so why not take
advantage of it? As you become
more confident and experienced,
you can experiment with creating
your own templates that fit the
 current trends in slide design.

Step 5: Add slide transitions. When
the slide show moves from one
slide to the next, that’s called a tran-
sition. PowerPoint comes preloaded
with numerous interesting slide
transitions. Some transitions are
 simple; the slides could drop down
from the top of the screen. Some
are much more dynamic; the slides
could swirl in a spiral shape.
I recommend that you tailor both

your template choice (see step 4)
and your slide transitions to the
 context of your presentation. In the
example about the weight loss
speech, no presenter would want a
template that is pink with pictures
of donuts and candy all over it, with
the slides bouncing in. That might
turn people off or actually make
them hungry! You can also have the
slides transition on their own, so
they could automatically change
every five seconds, 10 seconds,
etc. – any time interval you choose.

“You should have only the most
vital information on each slide.”
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the
Sidestep

Trap
PowerPoint

By Ellen Finkelstein, CC

R
ecently, I conducted a survey on the topic “Death by

PowerPoint.” One respondent wrote: “I think presenters

use PowerPoint slides for their own comfort level, not as

a communication device for the audience…. I really despise

someone flashing bulleted lists and then reading the lists to me.”

Make every slide a
source of pride.

As a Toastmaster, you know how to create and
 deliver a speech, or at least you’re well on your way.
Yet often when good speakers begin to incorporate
Microsoft PowerPoint slides into their speeches, they
fall into the “bullet trap.” The results for the presenter
can be dismal and can include:

� Slides that bore people to sleep.
� A speech that is reduced to outline form.
� A speaker who relies on reading the slides, just
because the text is there. 

� A lost connection with the audience, because the speak-
er is looking at the slides instead of making eye contact. 
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show it. Then, the photo portrays an example. The little
boy is reading a picture book. On one page of the book
is the text that tells the story. On the other page is an
illustration that shows the story. 
Many presenters rely on the slide backgrounds that

come with PowerPoint. These are mostly irrelevant and
look old and tired, because we’ve seen them before. In
fact, without a background, your presentation will look
more up to date. Creating presentations without back-
grounds is a fairly new trend. The best PowerPoint design-
ers are starting with a blank slide and working from there.

� Create a
makeover.
How would
you make over
a slide like this
one? It looks
familiar, with a
stock back-
ground and
bulleted text.
It describes the
components of a  presentation.
One way would be to divide it up into three slides.

Putting one point on a slide is a technique that helps
you avoid bullets. The three slides might look like this.

This presentation and the images are available for
download at the URL given at the end of this article.
You can apply the following steps to create the same
effect in new shows. Or you can use your own presenta-
tion, with minor adjustments to the instructions. Follow
these steps in PowerPoint 2002, 2003 or 2007:

1. Remove the background. With the slide displayed,
click the Design button on the Formatting toolbar
(located above the slide) to display the Slide Design
task pane on the right. In the Available for Use sec-
tion, choose the white background; its tooltip reads
Default Design.pot. (In PowerPoint 2007, click the
Design tab and choose the first blank thumbnail
image, called Office Theme.)

2. Duplicate the slide. Click the image of the slide in the
far left pane and press Ctrl + D (Command + D on
the Mac) twice for a total of three slides. The original
slide tries to make three points, so you’ll now place
one point on each slide.

What happens when a presenter displays a slide
containing text? The audience sees the text on the
slide and reads it. While people are reading, they
aren’t paying attention to the speaker. Why? Brain
research has shown that the brain doesn’t multitask
very well; it focuses on one thing at a time. Because
audience members can read faster than the speaker
can talk, they finish early. Then they turn their atten-
tion to the speaker and find that he or she is still
talking on the subject they’ve read. So naturally,
they’re bored!
We know from our own experience that text-based

slides aren’t very interesting. So why do we often fall
into the bullet trap? In a sense, PowerPoint is to
blame, because its default slide is a bulleted list. Look
at the instruction “Click to add text.” PowerPoint is
practically
ordering you
to create bul-
leted lists!

� Resist the
temptation.
You can avoid
the bullet trap
by remember-
ing that
PowerPoint is
just a visual aid and that bulleted text on a slide is not
an effective visual aid. However, most slides should have
some text. For motivational and inspirational speeches,
one or two words may be enough. For informational
and persuasive talks, use a slide title that actually says
something. For example, instead of “Results of stress,”
you could write, “Stress hinders our ability to function.”
Give audience members a summary of your point quick-
ly so they can immediately turn their attention to your
explanation of it.

� Tell ‘n’ show. After you add a slide title, how do you
fill up the rest of the space? Use images, diagrams or
graphs, depending on the point you’re making. I call

this the Tell
‘n’ Show(SM)

method. This
slide illustrates
the point.
First, the slide

has a title that
tells you some-
thing – that is,
to tell the point
and then to
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3. Format the Slide Master. To get a professional look,
you should format the Slide Master, which controls
the entire presentation. Once you do, you’ll find that
you spend less time fussing with the look of individ-
ual slides. From the view menu, choose Master> Slide
Master. (In PowerPoint 2007, click the View tab and
click the Slide Master button. Click the top slide mas-
ter image in the left-hand pane.) 

You can format the text, but for the purpose of this
article, click the first line of text in the main box that
says, “Click to edit Master text styles.” Then click the
Bullets button on the Formatting toolbar to remove the
default bullets. (In PowerPoint 2007, you’ll find that
Bullets button on the Home tab.) Select the sub-levels
of bulleted text – Second Level through Fifth Level –
and press Delete (or Backspace) on your keyboard.

This next step will allow you to center or left-
align body text properly. If you don’t see a ruler
at the top of your slide, choose View> Ruler. (In
PowerPoint 2007, choose the View tab> Ruler.)
Select the main text in the central box. Notice two
gray triangles, an upper and a lower one, near the
left side of the ruler. Drag the bottom, gray triangle
to the left so that it’s aligned with the top triangle.
Choose View> Normal from the menu to leave the
Slide Master. (In 2007, choose Close Master View
on the Slide Master tab.)

4. Add the text. You can put the text on the top and a
visual component on the bottom (or vice versa), or
place them side-by-side. These instructions place
them side-by-side. To arrange the text so there’s room
for an image, click the first slide in the slide pane on
the far left. In the larger slide image in the central
pane, click anywhere in the text. This slide will con-
tain the first point, so select and delete the second
two points.

Edit the text so it contains a complete statement. I
wrote: “Write your content: your message, its organi-
zation, your
choice of
words.” If
you have
any text
in the title
area, delete
it. (The
instructions
to add a title
appear, but
won’t show
when you present in Slide Show view.) Click inside
the main text box, click the border of the box to
select it, and drag the middle-right circular handle to

the center of the slide so that the text takes up the
left half of the slide. If you want to center the text,
select it all and click the Center button on the Format -
ting toolbar. (In PowerPoint 2007, the Center button
is on the Home tab.) It should look like the slide you
see here.

5. Insert an image. The next step is to find a visual that
will help the audience understand your point. Don’t
use line art, also known as clip art; use photographs
instead. A photo can illustrate the point either literally
or metaphorically; it can also add an element of emo-
tion. You can take your own photos – a digital cam-
era is great for this purpose. You can find high-quali-
ty photos online on stock photo sites – a few are
even free. (See the Web page listed at the end of this
article for some sources.) Finally, you can use
Microsoft Office’s Clip Art library.

To use the images available with the download
(described at the end of this article), choose from the
Insert menu: Picture> From File, and navigate to the
location where you saved the download. (You’ll have
to unzip the download file first.) Choose the file
named content-woman.jpg and click the Insert button
in the dialog box.

To use the Microsoft Office Clip Art library instead,
you would choose Insert> Picture> Clip Art. Then, in
the Clip Art task pane that opens to the far right, click
the “Results should be” drop-down list and uncheck
everything except Photographs. Then, enter a search
keyword in the Search For text box. 

6. Edit the image. When you insert the image from the
download, you’ll probably need to move it. Click and
drag anywhere on the photo to move it to the desired
location; in the example shown, move it to the right
of the slide. 

If you use your own image, you may need to
resize it. To do so, click it to select it, and then drag
it by its corner handle. (Caution: If you enlarge a
small photo too much, it will look grainy.) 

7. Make final adjustments. Usually, you’ll need to make
some final adjustments, to move the text or wrap the
words appropriately. With a few minor changes, your
slide will look great and be much more powerful!

Repeat the process with the other slides. If you’re
working with the images in the download, use
design-paint.jpg for Slide 2 and delivery-man.jpg for
Slide 3.

� Add a diagram or chart. Instead of an image, you can
add a diagram or chart. PowerPoint has a diagram tool.
PowerPoint 2003’s diagrams are basic; choose Insert>
Diagram. PowerPoint 2007 has vastly improved this
 feature; choose Insert> SmartArt.
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The follow-
ing slide tells
us that the
three compo-
nents of a
 presentation
are a process,
rather than
unrelated
items. Now
it’s time to

show how this idea works by adding a chart.
To add a chart, choose Insert> Chart. PowerPoint’s

charting feature is too complex to explain in detail, but
you should remember to simplify the formatting so that
the audience understands the data easily. The tools pro-
vided will help you design the right chart for this task.

� Practice and deliver. When you add PowerPoint slides,
you need to practice working with the technology, while
not losing your connection to your audience. With limit-
ed text on the slides, you’ll need to use notes or perhaps
work harder to present without notes. A quick glance at
the slide should be all you allow yourself before you

face the audience and discuss the topic. Practice with
your slides until they function to support you, rather
than replace you. Your audience will appreciate your
attention!

� You are the presentation. Always remember that you
are the presentation; the slides are not the presenta-
tion. So be sure to sidestep the PowerPoint trap of
bulleted text. By using visual slides to enhance what
you’re saying, your speeches will be more successful
and rewarding.

Ellen Finkelstein, CC, former member of the Golden
Speakers Toastmasters Club in Fairfield, Iowa, is the
author of a number of books, articles and a course on
PowerPoint and presenting. Ellen can be reached at
www.ellenfinkelstein.com.

Editor’s Note: The author has created a page for
Toastmasters at: www.ellenfinkelstein.com/events/
toastmasters.html. There you can download the
PowerPoint file used in this article as well as the images
and a list of online photo sources, and get discounts
 especially for Toastmasters members.
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Bruce Tulgan
as pages for the United States
House of Representatives. They
became fast friends and 10 years
later formed RainmakerThinking.
Tulgan’s gift for helping people
reach their full potential started
with his own work team.
“I’ve never met anyone who

gets more enjoyment out of the
 personal triumphs of other people,”
Coombs says. “Bruce has developed
strong insights into the area of lead-
ership and management because
he’s passionate about those subjects
and the extensive research we con-
duct. But he also asks hundreds of
people every month about their
experiences in the workplace and
he’s an excellent listener.”
In his books, Tulgan shares

his insights on how to motivate,
manage and communicate with
employees. For example, in an
interview on ypulse.com regarding
his new book about Generation
Y – defined as those born between
1978 and 1990 – Tulgan says, “The
so-called ‘experts’ have got it all
wrong. [They] argue that, since
Gen Yers have always gotten a
 trophy just for showing up, maybe
the best way to manage them is to
give them lots of praise and basi-
cally, give them a trophy just for
showing up.” 
In contrast, Tulgan’s carefully

researched advice is to skip the
“thank you programs, praise

 programs and reward programs.”
He says, “The high-maintenance
Generation Y workforce calls for
strong leadership, not weak.”  
Young employees need realistic

expectations and “strong, highly-
engaged management,” Tulgan says.
“Give them boundaries and struc-
ture, negotiate rewards in small
increments and help them earn
things they need and want. Spell
out the rules of the workplace in
vivid detail so Gen Yers can play
that job like a video game: If you
want A, you have to do B. If you
want C, you have to D.” 
If they do, Tulgan says, managers

will be rewarded with “the highest-
performing workforce in history.”
Tulgan holds a fourth-degree

black belt in karate and is married
to author Debby Applegate, who
won the 2007 Pulitzer Prize for her
biography of Henry Ward Beecher.
Tulgan practiced law at a Wall
Street firm before founding
RainmakerThinking in 1993.

Don’t miss this opportunity to
hear Bruce Tulgan speak at the
Golden Gavel Luncheon on
August 13 at the Toastmasters
International Convention in
Mashantucket, Connecticut. For
Convention details and registration
forms, please see pages 29-31 or
visit members.toastmasters.org.

� In recognition of his influence
in the areas of leadership and
 management, as well as his skills
as a  communicator, Toastmasters
Inter na tional is pleased to present
the organization’s most prestigious
honor – the annual Golden Gavel
Award – to best-selling author and
management trainer Bruce Tulgan.
The New Haven, Connecticut,

resident is considered one of the
world’s top experts on the subject
of young people in the workplace.
As the founder and chairman of
RainmakerThinking, Tulgan has
helped thousands of companies get
the most from their employees. He
is the author or co-author of 17
books, published around the world
in different languages, including
Managing Generation X, and the
recent best-seller It’s Okay to be the
Boss. His newest book, Not Everyone
Gets a Trophy: How to Manage
Generation Y ( Jossey-Bass), was
released in March.
Tulgan is also a popular and

compelling speaker; he shares his
expertise in Webinars and presenta-
tions to international business lead-
ers and managers of big-name
 organizations, ranging from Aetna
to Wal-Mart to the YMCA.
Few people know Tulgan better

than Jeff Coombs, a co-founder of
RainmakerThinking who runs the
company’s business operations. The
two met in 1983, when both served

Announcing Toastmasters’
2009 Golden Gavel Recipient:

T
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